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For those of you who are moving from
AutoCAD® 2009 to AutoCAD® 2010 you
should feel right at home with the user
interface.

Initial Setup
When you load AutoCAD 2010 you will
be asked to select the industry and settings that best suit you. AutoCAD will in

turn create a drawing environment that
addresses your selections for drawing
templates, tool palettes, and when visiting www.autodesk.com. No worries if
you bypass this screen as you can also
ﬁnd Initial Setup on the User Preferences
tab in OPTIONS.

AutoCAD will also create a new workspace based on your selections and add it
to the other default workspaces.

of tabs, each tab is made up of multiple
panels, and each panel is made up of
multiple tools.

Ribbon

You can drag panels oﬀ the ribbon to
display as a “sticky” panel. Sticky panels
stay put even if you switch to another
tab. Of course the Ribbon is completely
customizable and you can even create
your own ribbon tabs that change
automatically when a speciﬁc object is
selected or command is executed. AutoCAD 2010 now displays up to three rows
of icons so you can get to the tools you
need even faster!

The Ribbon, introduced in AutoCAD
2009, is more contextual than ever as it
automatically takes you straight to the
tools you need (meaning less clicks for
you!). The task based Ribbon is made up

If you resorted to the AutoCAD
Classic workspace in AutoCAD 2009, be
sure to give the new smarter Ribbon a try
in AutoCAD 2010!

User Interface

User Interface
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Quick Access Toolbar

Application Menu

Located in the upper-left corner of the
screen is the powerful Quick Access
toolbar. Here you will ﬁnd the frequently
used New, Open, Save, Undo, Redo, and
Plot commands. Selecting the downarrow allows you to quickly customize it
with your favorite commands. Here you
will also ﬁnd the option to return the
menu bar to the screen or display the
Quick Access Toolbar below the Ribbon.

Here you’ll ﬁnd commonly used File
tools as well as recently viewed ﬁles. Be
sure to pin frequently used drawing ﬁles
so they don’t fall oﬀ the list! You can
display recently viewed ﬁles as images
or icons as well as group them by Access
date, size or ﬁle type.

You can also run a quick query in search
of any AutoCAD command. A doubleclick on any listed item will launch the
associated command.

InfoCenter
You will ﬁnd the InfoCenter a quick
means to search for help, including information that resides online. Just click the
arrow to open or close the search ﬁeld.

Status Bar
If you are upgrading from AutoCAD
2008 or earlier, you’ll notice some nice
improvements to the Status Bar. A right
click on any tool lets you choose to view
text or icons for the standard settings,
such as Osnap, Grid, and Dynamic Input.
Standard settings turn blue making it
easier to see which settings are on (much
appreciated!).

It’s really easy to drag any Quick
Access Toolbar from one workspace to
another in the CUI.

Right-clicking many of these options
(such as Polar or Osnap) also enables you
to make quick work of changing the settings (thus saving you two extra clicks).

User Interface

User Interface
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Parametrics: Geometric Constraints

Tooltips
Tooltips have been expanded to provide
more information as you need it. The
longer you hover the cursor over a tool,
the more information appears. (You can
control this feature in more detail on the
Display tab in the Options dialog box.)

Hidden Message Settings
Throughout the application, warning
messages have been updated to provide
more help. Should you decide to turn
them oﬀ, they become hidden messages.
It’s easy enough to turn them back on
in the Systems tab in the Options dialog
box.

The Dashboard
For those of you who customized your
Dashboards, you can now bring them
into AutoCAD 2010 through the Transfer
tab in the CUI command. Simply right
click on the selected dashboard panel
to copy it to a ribbon panel in the same
CUI. Then simply drag and drop it to the
main CUI.
And if you prefer all of your ribbon tools
to be located vertically, similar to the
Dashboard, simply undock it and anchor
it to the left or right side of your screen.

The addition of Parametrics to AutoCAD
2010 is going to make your AutoCAD
objects smarter than ever! Two powerful
components of Parametric Drawing are
geometric constraints and dimensional
constraints—and now AutoCAD has
both!

The Ribbon is the way to go when
deﬁning geometric constraints. The
Parametric tab makes it easy to add
and control geometric constraints. You
can also use the GEOMCONSTRAINT
command.

Geometric constraints allow you to create a relationship between objects or key
points on objects. Whereas traditional
object snaps are temporary, constraints
stay with the objects to ensure you are
able to keep the design intent. For example, you may want two lines to always
be perpendicular to each other, or an arc
and a circle to always be concentric.

Simply select a geometric constraint
tool, such as parallel, and select the two
objects you want to maintain a parallel
relationship. The object selected ﬁrst is
key here as the second object will adjust
to be parallel to the ﬁrst. Such is the case
with all the geometric constraints.

Adding Constraints

Parametrics: Geometric Constraints

User Interface

Check out the new Hide XREF
Scales option added to the VP Scale list.
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A quick Constraint Primer:

Collinear Makes the second
object lie in the same inﬁnite line
as the ﬁrst.
Concentric makes two arcs,
circles or ellipses (or a combination) share the same center.
Fix Locks a point on an object to
a coordinate in the WCS.
Parallel Makes two line or pline
segments parallel. (Perpendicular:
Makes two lines or pline segments
perpendicular.)
Horizontal Makes a line or two
points on an object horizontal
(parallel to the X axis).
Vertical Makes a line or two
points on an object vertical (parallel to the Y axis).

Tangent Makes two objects such
as an arc and a line tangent to
each other.
Smooth Makes a spline contiguous with another line, arc, pline
or spline while maintaining G2
continuity.
Symmetry Imagine a mirror command where the objects continue
to maintain symmetry after the
fact!
Equal A real time saver as you
can set any two lines to always
maintain an equal length or
two circles to have the same
radius. You modify one, the other
updates automatically! A nice
multiple option here as well.

Geometric icons appear on the objects
to indicate the attached constraints.
These constraint bars can be dragged
to any position on the screen, hidden
by selecting Hide All from the ribbon or
turned back on with Show All. The Show
option lets you to select the objects you
want to display constraint bars.
Manage a variety of constraint bar options in the Constraint Settings Manager.

AutoConstrain
This is the best tool ever! Select a group
of previously drawn objects and AutoCAD will automatically constrain them
for you! Use the AutoConstrain tab in
the Constraint Settings manager to set up
priority, tolerances, etc. (CONSTRAINTSETTINGS command if you don’t want to
use the ribbon)

Parametrics: Geometric Constraints

Parametrics: Geometric Constraints

Coincident Insure that two objects coincide at a speciﬁc point.
The point can also lie anywhere on
the extension of an object.
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Parametric: Dimensional Constraints
The geometry in AutoCAD has always
driven the dimensions. We draw a line
the correct length and then dimension
the line. What if you could drive the
geometry from the dimensions? You
change the value of the dimension and
the geometry automatically updates!
That is exactly what we now have in
AutoCAD 2010.
You’ll ﬁnd the dimensional constraints
located in the center of the Parametrics
tab on the ribbon. You can also use the
DIMCONSTRAINT command.

Here you will ﬁnd the standard types
of dimensions, but these dimensions
are able to drive our geometry. For
example, you can dimension a circle with
the Radial option and later control that
circle by simply changing the dimension
value. You’ll want to use Dimensional
Constraints on geometry you want to
be able to easily change or on geometry you want to constrain to a speciﬁc
size. If the distance between two holes
needs to always be 3mm, constraining
it dimensionally will force that distance
regardless of what happens to the rest of
the geometry.
You can change a traditional dimension to the new constrained dimension
with the DIMCONSTRAINT command

A lock icon displays to help you visually
distinguish a constrained dimension
from a traditional dimension. Their size
is zoom-invariant (always the same size)
and geometrically constrained dimensions do not plot. You’ll notice that each
is assigned a name such as D1 or Ang1.
These names are completely customizable in the Parameters Manager and you
can create your own user parameters.
Expressions can be set to be dependent
on other values as well.

The Constraint Settings manager
controls the display of your dimensional
constraints. Here you can switch the
values to display without the expression
or turn oﬀ the lock icon.

You can easily edit a dimensional constraint with a double click on the dimension text or by changing the value in the
Parameters Manager. You can rename
the constraints in the fashion as well.

Parametric: Dimensional Constraints

Parametric: Dimensional Constraints
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Dynamic Blocks and Parametrics

So what if you’d like to print these
dimensional constraints? No problem—
simply select the dimensions you want to
print and convert them to Annotational
dimensions in the Properties Manager.
Here you’ll be able to control their style,
size, etc.

The good news is that these are still
the smart geometric constraints which
means you can still double click on them
to change their value!

Great news! Parametrics can now be
combined with the power of dynamic
blocks!

Updated Block Editor
The block editor ribbon tab has been
enhanced to contain both geometric and
dimensional constraints.
A new tab has also been added to the
block authoring palettes speciﬁcally for
parametric constraints.
If you prefer to work with annotational dimensions from the beginning,
set the CCONSTRAINTFORM system
variable to 1 or select the Form option in
the DIMCONSTRAINT command.

Assigning geometric constraints in the
block editor works much the same as
in the drawing editor. If you bring constrained geometry into the block editor
it will remain constrained.

Dynamic Blocks and Parametrics

Parametric: Dimensional Constraints

Changing to Annotational
Dimensions
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Dimensional Constraints

Test Blocks

Block Table

Dimensional Constraint parameters
can also be added to dynamic block
geometry. Their name is in turn exposed
as a property for the block, much like
the standard dynamic block parameters.
When attaching Dimensional Constraints
to block geometry, you can also control
the number of grips available to the user
for editing purposes.

No longer do you need to exit the block
editor to test your blocks! The new Test
Block tool lets you try your block out
without requiring you to save changes
and exit the block editor (which will save
you plenty of time!).

Here you can really kick up the power
of your dynamic blocks! Using the Block
Table tool (BTABLE), you can deﬁne
diﬀerent variations of a block. You can
key these variations in manually or paste
them in from an Excel spreadsheet.

Be sure your constraints are contained in the block deﬁnition, not added
after the fact for the best results.
Be sure to stick to the Block Editor
ribbon when attaching dimensional
constraints (don’t grab them from the
Parametrics tab!)

Construction Geometry
Now you can create construction geometry that displays in
the block editor but not on the inserted
block. The new BCONSTRUCTION tool
makes it easy to convert existing geometry to construction geometry which
displays in a gray dashed linetype.

Parameters Manager
You can access all of the assorted block
parameters and attributes in the new
Parameters Manager. You can control
whether a parameter is displayed in the
Properties palette and the order that the
parameters appear.

You can even further control the block
insertion by selecting the Block properties must match a row in the table thus
avoiding the creation of random nonstandard parts.

Dynamic Blocks and Parametrics

Dynamic Blocks and Parametrics
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A grip on the inserted block lets you
quickly switch between the diﬀerent
values listed in the Block table. Selecting
Properties Table from the grip menu
displays the entire block table so you can
see all the values and even sort on diﬀerent columns.

Block Editor Settings
You can control all the settings for the
block editor environment in the Block
Editor Settings dialog—including colors,
sizes and alignment options.

Use these handy tricks to buy yourself
some time when annotating your drawings in AutoCAD 2010.

Find
The updated FIND command now
includes a Zoom button in the results list
to ensure you remain zoomed in on the
found item after exiting the command.
The new selection set tools make it easy
to create a selection set out of the found
results.

Mixing the new geometric and
dimensional constraints with the traditional parameters and actions can lead to
varied results and is not recommended.

These new tools are only visible
when the List results box is checked.

Multileaders
Multileader Styles now let you specify
vertical attachment settings (Content
tab) and you can specify a scale for a
block type of multileader.
Now you can access the Text
Style dialog from the MLEADERSTYLE
command.
Annotation Step Savers

Dynamic Blocks and Parametrics
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Annotation Step Savers

Object and Layer Properties
MTEXT and Spell Check

Dimensions

Use ESC to Exit MTEXT
Now when you click Escape in the
MTEXT editor, the software gives you a
chance to save your text (no more losing
your text edits!). Make this the default if
you choose.

You can now assign a text placement option below the dimension line in the Text
tab of the Dimension Styles dialog box.
You can also specify the text direction as
Left-to-Right or Right-to-Left.

In-Place Spell Checking
Catch those spelling errors as they are
happening in MTEXT. AutoCAD underlines in red those words that are not in
the dictionary, and the right-click menu
oﬀers spelling suggestions.
A new Sub-units factor and suﬃx have
been added to Zero Suppression. This
would make it easier to get a text value
such as 45 cm rather than .45m.
A new Undo button has been added to
the SPELL command, and, its one click
faster to select objects to spell check.

See how object and layer tools in
AutoCAD 2010 can make your dreams
come true.

Quick Properties
The Quick Properties tool enables you
to view and modify object properties
in place, without having to go to the
Properties palette. You can turn Quick
Properties (QP) on or oﬀ from the status
bar. After turning the feature on, simply
select an object and the properties
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display for editing. You can control which
properties are displayed for each object
in the CUI (for speedy access select the
Customize button in QP).

Layer Management
The Layer Properties Manager is modeless so you can keep it displayed as you
use other commands. That means you
can dock, autohide, or anchor it just like
your other tool palettes. And it is now
dynamic—any changes you make in the

Object and Layer Properties

Annotation Step Savers
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Layer Properties Manager are instantly
applied to the drawing (no more
“Apply”).
If you have ever had a hard time viewing
the layer name column when you slide
over to the right side of the column, you
will be happy to know that now you can
freeze columns so they stay put as you
use the slider bar. By default the Name
column is frozen. If you need more real
estate in the dialog box, you can now
collapse the Filters pane.

Now you can access the Select Color
dialog box directly from the Layer dropdown list by selecting a color swatch. If
the layer has a viewport color override
it now has a white border. It’s also much
easier to tell which color you are looking
at in the Select Color dialog with the
new black border and arrow!

The new, more visual measuring tools in
AutoCAD 2010 will make quick work of
mining valuable information from your
drawing.

Angle

The Utilities panel of the Home ribbon
contains the new updated measuring
commands (These are also found in the
MEASUREGEOM command).

Area

Distance
Used to measure the distance between
two points, AutoCAD 2010 now visually
displays the distance, delta x, delta y
and the angle (in the xy plane) A new
Multiple option allows you to continue
to pick points as AutoCAD displays a cumulative distance. If you need to include
an Arc in the distance you can easily
switch to Arc mode.

Quickly measure the Angle between two
lines, of a vertex, two points on a circle,
or an arc.

Much improved over the standard AREA
command, visual feedback makes your
selection clear. Add and Subtract options
are also available in the new Area option
with the subtracted areas displaying in
a diﬀerent color. An arc option makes it
easy to measure curved spaces.

Radius
Use the new Radius tool to quickly display the radius of a selected arc or circle
(Quick Properties would also work here).

Volume
Easily add a height to a boundary to
calculate the volume. You can also ﬁnd
the volume of solids and regions.

Measuring Tools

Object and Layer Properties
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Measuring Tools
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Step Savers
These features will really help you boost
your productivity.

Hatch
Two nice new features with crosshatching have been added. Now it’s easy to
edit non-associative hatch patterns with
grips! And if AutoCAD ﬁnds a gap in your
hatch boundary, it will point out the gap
with two red circles.

Spline to PLINE

Rotated Viewports

Export Layout to Model Space

A new convert to Polyline option in
the SPLINEDIT command lets you
quickly make the conversion. You will be
prompted for a precision value between
0 and 90 with the higher value being
more accurate.

When you rotate a viewport in AutoCAD
do you want the view to rotate with
it? Well now you have a choice. When
VPROTATEASSOC is set to O the view
will not rotate. When VPROTATEASSOC
is set to 1 (the default) it will!

You can export all visible objects from
the current layout to model space with
the EXPORTLAYOUT command.

Too high a value could impact
performance.

Speedy WBLOCKs

Step Savers

Have you ever had a linetype with text
heading the wrong direction with the
text upside down? The new REVERSE
command makes it easy to reverse the
direction of any linetype. This option
has also been added into the PEDIT
command.

Should you decide to turn an existing
block or dynamic block into a WBLOCK,
it is easier than ever. Simply select the
block, enter W for the WBLOCK command, and your selected block is ready
to go.

Purge
A new option for purging zero-length
geometry and empty text objects has
been added to the PURGE command.
This should really help clean up your
drawing!

Missing Printers Identiﬁed
VPROTATEASSOC=0

VPROTATEASSOC=1

Missing printers are now identiﬁed with
a “Missing” preﬁx instead of a suﬃx—no
more accidental truncation of that key
piece of information.

Step Savers

The new system variable PLINECONVERTMODE controls whether straight
segments (0) or arcs (1) are used. You can
also select a spline object in the PEDIT
command and convert it to a pline.

Reverse

Objects that are outside the
paper boundaries of the layout are also
exported.
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External Referenced Files
Recover Drawings Along
with Xrefs
Now you can run the recover process on
a drawing and all the associated xrefs.
Find this capability in the Application
menu under Drawing Utilities or use the
RECOVERALL command.

ever to control the publish property
of multiple sheets. You’ll also ﬁnd the
updated Sheet List Table dialog has many
nice enhancements including the ability
to create a sheet list from a subset of
sheets.
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(PDF, XREF, DGN, DWF and Image ﬁles)
The Reference panel on the Insert tab of
the Ribbon makes it easy to attach and
modify all of your externally referenced
ﬁles. You’ll ﬁnd a one stop shop that
helps you easily clip, fade (even Xrefs!)
and control the display of reference
frames along with other valuable tools.

You no longer need to save your drawing before executing the ETRANSMIT
command. You will also ﬁnd the handy
Purge option in the Transmittal Setup
dialog box to help ensure that you are
sending nice, clean drawings. You can
now include unloaded ﬁle references in
the transmittal set.

Sheet Sets
An additional option on the Sheet List
shortcut menu enables you to publish in
reverse order. Selecting Edit Subset and
Sheet Publish Settings from the right
click menu sends you to the new Publish
Sheets dialog box making it easier than

User Interface

Step Savers

ETRANSMIT Enhancements

Auto-Complete in File dialogs
File Navigation dialogs now support
auto-complete (thus saving you time
when typing ﬁle names).

Context Sensitive Ribbon
You’re going to love how the context
sensitive ribbon automatically displays
only those commands which are relevant
when you select one of your externally
referenced ﬁles. The options that appear
on the ribbon are the options that relate
to the selected type of object!
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OSNAPS only
work in PDFs created
from AutoCAD.

Attach PDF ﬁles!

Working with DGN Files

The super good news is that now you can
bring a PDF into AutoCAD (as an underlay). You can clip the PDF, snap to the
PDF, control layer visibility and fade the
PDF. Easily edit the clip boundary with
grips, much like you can with an XREF
and even invert the clip boundary.

Now you can attach Bentley
MicroStation® V7 and V8 DGN ﬁles
to your AutoCAD drawings or export
DWG ﬁles to V7 and V8 DGN. Clip
the DGN from the context sensitive
ribbon, control layers and adjust the
contrast, fade, and monochrome (or
DGNADJUST).

The DGNMAPPING command maps
DGN levels, linestyles, lineweights, and
colors to AutoCAD layers, linetypes,
lineweights, and colors (and vice versa).

Frames
A new FRAME system variable lets you
control the visibility of all your externally
referenced ﬁles. This can be easily found
in the context sensitive ribbon and
overrides the individual frame system
variables (such as IMAGEFRAME).

Lost Reference Files
Nothing is more frustrating than opening
a drawing and ﬁnding out an externally
referenced ﬁle is missing! Now AutoCAD
makes it easier than ever to locate them
by greeting you with a new tool that can
take you straight to the External References Palette.

External Referenced Files

External Referenced Files

Import V7/V8 DGN data with DGNIMPORT or the Import tab on the ribbon.
When importing, you see a dialog box
that prompts for information regarding
external DGN references, text nodes,
and units to help you get the best
results.
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Action Recorder
Create Smaller and Higher Quality
PDF Files!

Be sure to select DWG to
PDF.PC3 in the Plot command.

Default vector resolution has been increased from 400 dpi to 600 dpi (better
lineweight precision). True Type fonts are
exported as text now (rather than graphics) thus decreasing the ﬁle size and
lending itself to searching and copying
text in the ﬁnal PDF. You can also specify
merge control, include layer information
and automatically view the PDF ﬁle when
ﬁnished.

You can ﬁnd similar options on the
Output ribbon tab under Export to DWF/
PDF Options including the ability to
specify multi-sheet.

Imagine being able to quickly and easily
record your drawing steps for repeat use.
All designers have tedious tasks they do
throughout the design day—now you
can record it once and replay it as many
times as you want. You can even include
such features as pausing for user input,
selecting objects, and more.

version of your macro appears in a box
(the Action Tree) for you to view. A ﬁle
with an extension of .actm is then saved
to the directory indicated in Options.

On the Manage tab, simply click the
Record button on the Action Recorder
panel to start recording your steps.

• Right-click any action line of your
macro to pause for user input (for
example, you want the user to input
the radius of a circle).

Now you are ready to try your macro by
clicking Play.
From the Action Tree you can:

• Right-click any action line of your
macro to insert a user message to help
lead your user.
• Double click on values to edit.
A new tool lets you add base
points into your action macro.
The Action Recorder records actions
from the command line, toolbars, ribbon
panels, pull-down menus, the Properties
window, the Layer Properties Manager,
and the Tool palette.
After you are ﬁnished with your task,
simply click the Stop button. You are
prompted for a Macro Name, and a text

Action Recorder

External Referenced Files
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Macros don’t understand dialog boxes
except for the Layer Manager and Properties dialog boxes. All other commands
with dialog boxes need to be run at the
command line, with a dash [–] in front of
the command. For example: –HATCH. An
Action Macro can get you into a dialog
box, but the user would need to enter
any information and exit manually.

The Preferences button enables you to
determine the behavior of the Action
Tree.

If you plan on working in 3D be sure to
switch to the 3D Modeling workspace.
This will insure the 3D tools display in
the Ribbon.

The 3D Gizmo
The new Action Macro Manager makes it
easy to organize your macros.

AutoCAD 2007
introduced the gizmo
with 3D Move and
3D Rotate options. A
new 3D Scale gizmo
has been added for
even more 3D functionality.

If you are using a 3D visual style the
gizmo will display when an object is
selected. The Sub-object panel on the
Home tab makes it easy to change from
one gizmo mode to another.
3D Tips

Action Recorder
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3D Tips
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You can also go directly to a speciﬁc
gizmo with the 3DMOVE, 3DROTATE and
3DSCALE commands. You’ll ﬁnd that the
new AutoCAD 2010 gizmos go directly
to the center of the selection set (saving
you that extra step).

In the past it has been tricky selecting
between an edge, face or vertex. The
Subobject panel on the Home tab also
makes quick work of this now!

You can also access these selection options from the right click menu (when no
objects are selected yet).

Remember that you need to use the
Ctrl key to pick subobjects.

New Surface Options
The Solid Editing panel of the Home tab
now lets you perform unions, subtractions, interferences, intersections and
imprinting on surfaces as well!

You can also change to a diﬀerent gizmo by hitting the space bar after
selecting an axis

3D Printing
Use the new 3DPrint command to send
your 3D AutoCAD drawings to a STLsupported 3D printing vendor. A friendly
utility will walk you through the steps
needed to ensure your model is 3DPrint
ready. After selecting the solid objects
you want to print you will ﬁnd yourself in
the Send to 3D Print Service dialog. Here
you’ll ﬁnd a friendly preview pane and
scale controls (with a helpful ﬁnished
output size). A ﬁnal OK will send you to a
site with possible 3D Printing vendors.

3D Tips

3D Tips

A right click on a gizmo enables you to
modify the gizmo’s behavior. Here you
can constrain to a diﬀerent axis or plane,
relocate it and realign it.

Selecting edges, faces and vertices
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Mesh Modeling
Use the Smooth Object tool to turn
a 3D solid object into a mesh object.

You can split or extrude a face in the
Mesh Edit panel.

To create a hard edge on your mesh you
can use the Add Crease tool.

You’ll want to make sure you use the
Ribbon here as all of your Mesh Modeling tools can be found in one location.

By default, your meshes are created with
no smoothness. You can easily smooth
them with the Smooth More option in
the Mesh panel.

You’ll ﬁnd familiar shapes such as Box,
Cone and Cylinder in the Primitives
panel. Set up the number of tessellation lines in the Mesh Primitive Options
dialog box.

You can control the level of smoothness
(maximum 4) along with many other
mesh parameters in the Mesh Tessellation Options dialog.
Continue to Smooth your meshes more
or less based on your requirements.
Reﬁning a mesh will increase the number
of faces on your mesh.

The biggest bonus? You can convert the
watertight meshes (no gaps) to solids.
These and more conversion tools are
available in the Convert Mesh panel.

Mesh Modeling

Mesh Modeling

The new Mesh Modeling makes it easy
for you to do free-form design.
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Added Extras
Autodesk Seek

Simply open your DWF or DWG ﬁle in
Impression and add strokes, textures,
ﬁlls, and entourage (such as people,
plants, and cars) to create your own
custom illustration.

located on the Output tab of the Ribbon
(or execute the SHAREWITHSEEK
command).

Getting Started
Use the Jump Start Tour to help you
begin using Impression, with easyto-follow, step-by-step exercises and
informational videos. And if you want an
even more in-depth introduction to the
application, check out the Quick Start
Guide on the Help menu.

Added Extras

Autodesk Labs
Be sure to visit to visit Autodesk Labs
to stay up and running on tomorrow’s
technology. At labs.autodesk.com you
can download (for free) many cool tools
regardless of your discipline.
And if you should decide you’d like to
share your designs with others you can
use the Share with Autodesk Seek tool
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Impress colleagues and clients with
graphics created directly from your CAD
drawings with Autodesk® Impression
software (available to subscription
customers only). Now you can bypass
the tedious and time-consuming task of
creating graphics by hand or importing
CAD ﬁles into graphics software for
polishing.

Stroke Type
Try assigning a custom stroke style to
incoming lines as you open a DWG ﬁle in
Impression. Use the Import DWG wizard
to select a favorite stroke for all incoming lines regardless of their layer. This
can give your DWG ﬁle a hand-drawn
look before you even start rendering.

Bonus Section: Autodesk Impression

Don’t miss out on the great content
available (for free!) up on Autodesk Seek.
Easily accessed from Design Center you
will ﬁnd 2D and 3D drawings, DWFs,
PDFs, etc available for you to download
and use.

Bonus Section: Autodesk Impression
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Autodesk Design Review
the blocks height. You can also make the
drop shadow appear inside the style for a
pool or sunken eﬀect.

Area Fill
Color in multiple areas quickly by using
the Freehand option in the Area Fill tool.
Drag a freehand spline path across the
areas you want to ﬁll in. Everywhere
the spline crosses a bounded area, the
selected ﬁll style will be applied to
the area.

Drop Shadow Eﬀects
Adding a drop shadow eﬀect to a style is
a great way to add the illusion of depth
to your illustration. For example, create a
style with a drop shadow eﬀect that you
can assign to landscaping blocks such
as trees or shrubs and it appears to give

Creating custom style libraries in
Impression can be a laborious and timeconsuming task. In order to create a
new library you have to manually copy/
create each style and modify the color
of individual style elements one by one.
The Style Book Wizard automates this
process by generating a pre-determined
number of color variations based on
an existing “source” style (and that will
deﬁnitely speed things up!)

Make it easy for your colleagues who
don’t use CAD. When you publish to
DWF™ (or DWFx) format, your colleagues can use Autodesk® Design
Review software to view, measure, mark
up, and track changes to any design.
Autodesk Design Review 2010 new
features:
• Enhanced user interface. Design
Review now has a more intuitive,
task-based look, consistent with other
Autodesk products.

• Save Markups Summary. Design
Review can now save a summary of all
DWF ﬁle markup properties to a CSV
ﬁle.
• Digital signatures. To help secure your
data, you can now digitally sign DWFx
ﬁles. And lots more!
The free download is available at
www.autodesk.com/designreview.

• Enhanced DWG viewing experience.
Use Design Review to easily open and
view DWG ﬁles.
• Highlighters. Use the highlighter
markup tools to draw attention to
speciﬁc information.
• Enhanced line formatting options.
Change line patterns and line start and
end styles to modify the appearance of
your markups.

Be sure to specify the resolution for
vector and raster graphics when creating
DWF ﬁles—it allows for much greater
precision!

Autodesk Design Review

Bonus Section: Autodesk Impression

Create a new set of styles—
quickly!

Lynn Allen, Cadalyst columnist and worldwide
Autodesk Technical Evangelist, speaks to more than
30,000 users each year. For the past ﬁfteen years she
has written a monthly column in Cadalyst magazine
called “Circles and Lines” and is the voice behind
Cadalyst’s “Tips and Tricks Tuesdays”. Lynn started
using AutoCAD® software with Release 1.4, over 20
years ago, and got her start by teaching at the corporate and collegiate level for 12 years. A sought-after
public speaker with a unique comedic style, Lynn has
served as the Autodesk University emcee for ten years
and is always one of the highest rated speakers. Her
latest book is entitled AutoCAD Professional Tips and
Techniques.
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